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1. Introduction 

 
SF6 is a man-made gas used in high-voltage switchgear because of its great arc 
quenching capabilities.  Partial discharges and leaks over time eventually cause 
the SF6 to decompose into highly corrosive compounds.  It is therefore essential to 
monitor the condition of the SF6 to protect the equipment from spark damage and 
corrosion. 
 
The Rapidox SF6 Multimeter is a multi-gas analyser for the simultaneous 
measurement of SF6 (0-100%), SO2 (0-100ppm) and H2O (-65+20°C dewpoint).  
The analyser is designed for controlling and monitoring the quality of SF6 in gas 
insulated sub-stations and circuit breakers.  The analyser not only measures the 
SF6 gas content in air or nitrogen over the full range, but also measures the 
moisture content of the SF6 which is essential when monitoring the dielectric 
strength of the gas.  The decomposition products of SF6 can be identified by 
analysing the SO2 content of the gas; this forms from the breakdown of SOF2 and 
SOF4  after an electrical discharge.  The analyser incorporates an electrochemical 
SO2 sensor to measure ppm levels of sulphur dioxide. All three gases can be 
monitored and data-logged simultaneously and just a few minutes are required to 
get a stable reading. 
 
Regular checking of SF6 gas insulated substations allows fault preventative 
maintenance programs to be implemented, and increases the life cycle of the SF6. 
 
The analyser has a gas output nozzle allowing all sampled gas to be recovered and 
recycled, ensuring that no SF6 gas is released into the atmosphere (in accordance 
with the Kyoto agreement) 

2. Features 
 

 Continuous gas sampling of SF6 - SO2 - Moisture (dp OR ppm(v)) 
 

 High precision catharometer for SF6 analysis over the range 0-100% 
 

 Electrochemical SO2 sensor for trace analysis of contamination gas 0-100ppm 
 

 Ceramic dew-point sensor for moisture analysis -65°C to +20°C dp (or ppmv) 
 

 Sensor accuracy ± 1% of the full scale 
 

 Input pressure 0.5 to 10 bar 
 

 Gas flow rate 0.5 - 1 litre per minute controlled by flow gauge 
 

 Programmable alarms (low and high condition) with outputs and visual 
warning.  
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 RS232 / RS485, 0-5V or 4-20mA current loop outputs (both user 
programmable). 
 

 On-board data logging software with MS-Excel compatible graphing. 
 

3. Specification 
 

3.1 Rapidox SF6 Multimeter Dimensions 
 
The unit weighs approximately 6kg and is fitted with adjustable rubber feet. The 
unit is mains powered (110/240V 50/60Hz) and is supplied with mains cable. Case 
dimensions W=350mm; D=263mm; H=150mm.  Optional swing handle is 
available at the time of ordering. 
 

3.2 Accuracy and Precision 
  
Sensor response time is typically 5 seconds for a 90% response involving a step 
change in SF6 composition.  High accuracy is maintained between calibration 
points. Accuracy  ± 1% of the full scale SF6 content. 
 

3.3 Display 
 
The analyser has a 4-line 20x4, 9mm character, back-lit liquid crystal display 
(LCD), whose data update rate is user-programmable.  The LCD displays three 
significant figures of SF6.  The display notation is set to percent SF6, ppm SO2 and 
dew-point (or ppmv) moisture.  Units are all user-configurable via the menu or 
software.    
 
The ambient temperature display is -40°C to 125°C. 
 

3.4 Sensors 
 
The sensors are located inside the analyser and the sample gas flows over each 
detector in turn before exiting the front panel.  The gas is sampled using flexible 
tubing that connects to the front panel via special DILO style self-sealing 
couplings.  The flow rate is controlled using a flow gauge / needle valve on the 
front panel and is adjustable from 0 to 1 litres per minute.  SF6 sensor life 
expectancy is 5 years, and the sensor can be replaced by a skilled person in 
minutes. 

3.5 Calibration 
 
The simple and fully flexible calibration procedure for each sensor requires any 
two calibration gases (ambient air is normally used to zero the SF6 & SO2 sensors).  
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The calibration gas compositions are user-selectable and programmed into the 
Rapidox via the keypad menu or the RS232 / RS485 link and configuration 
software.  Factory pre-sets can be reloaded to allow the unit to be 'rescued' from a 
failed calibration.  The Rapidox is calibrated using the keypad on the front panel 
or the software supplied.  The LCD changes to calibrate mode to inform the user of 
progress. 
 

3.6 Operating Temperature 
 
Sample gas temperature entering the analyser must not exceed 50oC. The tubing 
inside the analyser is rated to 120oC.  The Rapidox unit normal operating 
temperature is -20°C-40oC. 
 

3.7 Outputs 
 
The RS232/RS485 serial port outputs on demand values for SF6 (%), SO2 (ppm), 
H2O (°Cdp, °Fdp or ppmv), temperature (Celsius or Fahrenheit), time (hh:mm:ss) 
and date (dd/mm/yy).  This data can be downloaded and logged using the software 
provided. 
 
Standard 0-5V and 4-20mA analogue outputs are available on the rear panel for 
both SF6 and the auxiliary (can be set to SO2 or H2O by the user), as are 5V (logic 
level) SF6 alarm signals (High and Low conditions).  These outputs are fully user-
programmable via the front keypad or RS232 link and the supplied configuration 
software. 
 

3.8 Data-logging 
 

The Rapidox has an on-board data-logging facility which will record up to 2048 
full sets of readings from all the sensors.  It is a rolling memory which will over-
write itself once full.  The data-speed and data-interval can both be set or logging 
can be left on continuously.  The memory can be downloaded using the software 
programme into an Excel compatible file. 
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4. Technical Specification 
 

Rapidox SF6 Multimeter:  Analyser 
Voltage 110 / 220V ac 50/60 Hz 
Analyser dimension 350mm X 263mm X 150mm 
Weight 7 kg 
Display 20 X 4 character (9mm) back lit  
Warm up time 3-4 minutes at 20°C 
Normal operating temperature -20 to 40°C 

Outputs 
0-5V linear (user programmable) 
4-20mA linear (user programmable) 
RS232 / RS485: data streamed on demand 

Rapidox SF6 Multimeter:  Sensors 
SF6 Sensor Katharometer 0-100% scale ± 1% FS accuracy 

Moisture Sensor Ceramic Dew-Point Sensor -65°C to +20°C dp.  
± 2°C FS accuracy 

SO2 Sensor Electrochemical Cell 0-100ppm ± 2% FS 
accuracy 

Life expectancy 3 to 5 years 
Sensor Drift <2% of span per month 
 

5. Precautions 
 
Make sure you read and understand these instructions and keep them safe for later 
use.  The unit should not be exposed to extreme temperatures < -20°C or > 50°C.  
Normal operating temperature is -20°C-40°C.  Avoid direct sunlight.  Do not use 
liquid cleaners, aerosols or solvents to clean the case.  Use a damp cloth for 
cleaning.  Do not use this equipment near water.  Avoid touching the LCD display 
as this may cause permanent damage.  Make sure the rear ventilation slots and the 
fan on the rear panel are free of obstruction. 
 
There are no user serviceable parts in this unit.  Do not attempt to repair yourself.  
Refer all servicing to qualified Cambridge Sensotec personnel. 
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6. Rapidox Operating Instructions 
 
 

Cambridge Sensotec

GAS IN
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GAS OUT

2
1

3
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Figure 1: Rapidox SF6 Multimeter front panel.  The numbers refer to the instructions below. 
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Auxiliary
4-20mA

ALARM
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ALARM
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COMMON

66

SERIAL

7 9

FanPower

Figure 2: Rapidox SF6 Multimeter rear panel.  The numbers refer to the instructions below. 

 
Ensure that the Rapidox analyser is located away from extreme heat and dirt 
environments.  Plug the unit in to a suitable supply (noting the information on the 
serial sticker and using the power cable supplied).  Connect your gas sampling 
tube (6mm OD 4mm ID) to the front gas inlet connector (2) using the self sealing 
coupling supplied.  If required a second tube can be connected to the gas outlet 
connector (3) and vented to the outside air or collected for recycling.  Turn the 
unit on using the red power switch on the front (5).  Select the required gas flow 
by adjusting the flow valve (4).  It is recommended that the flow is adjusted to give 
0.2-0.5 litres per minute. 
 
The LCD (1) will display the firmware version followed by the message 
“SENSORS SETTLING”.  The settling will take approximately thirty seconds, after 
which the Rapidox will begin to take measurements.  The progress of the warm-up 
is shown in the form of a bar graph on the LCD (1).  Once at temperature the LCD 
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display (1) will show the SF6 reading on line 1, the SO2 reading on line 2, the 
moisture reading on line 3.  Line 4 will display either ambient temperature or the 
time and date depending on how the user has configured the display.  The word 
*ALARM* may appear alongside the SF6 display if the alarm system is enabled 
and an alarm condition applies. 
 
Allow five minutes for the box to stabilise fully.  This allows the components of 
the analyser to reach a stable working temperature.  During this warm-up period it 
is common for the baseline readings to drift by a small amount, which may be 
corrected by re-calibrating. 
 

6.1 The Rapidox Analyser - Menu System 
 
All of the user-programmable functions are accessed via a menu system which is 
controlled using the front panel Keypad (2).  To access the menu press the ENT 
button and to escape and return to the operating screen press ESC at any time.  If 
the password security system is enabled then the user must enter the four digit 
password (factory = 0000) to continue.  This feature can be disabled by the user.  
Please see section 6.10 for full details about this feature.  If the menu is accessed 
and a button not touched within thirty seconds then the unit will automatically 
return to run mode screen. 
 
 
The menu system flow chart is shown in Appendix 1 at the end of the manual 
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6.2 Rapidox Calibration 
 
Once the unit is at temperature it may be necessary to calibrate the SF6 and SO2 
sensors.  Note that it is possible to also calibrate the dewpoint sensor but this 
should ONLY be attempted if you have access to the correct equipment (chilling 
mirror).  The dewpoint sensor is FACTORY calibrated and no further calibration is 
normally required.   Calibration will be necessary if you are using the sensor in a 
different measurement environment, to measure a different range of gases or if the 
gas flow changes significantly.  Full calibration is a simple procedure requiring 
only two gases (air is usually used for the base-line zero point).  The two gas 
values are user-selectable and can be changed by using the front keypad (6) or the 
communications software described in section 6.11.2, and the calibration values 
can be stored on file for later use. 
 
The SF6 detector requires a gas cylinder of 100% SF6 to correctly calibrate the 
span.  The SO2 detector should be calibrated using a 25 – 100ppm SO2 cal gas  
 
1) Bearing in mind the points made above decide which two gases you are 

going to use for calibration.  It would be wise to obtain small cylinders of 
SF6 and SO2 calibration gas with analysis certificates. 

 
2) Press the ‘ENT’ button on the front panel keypad (6) to access the menu 

system.  The calibration function is the first item on the menu list which 
can be scrolled using the up and down arrows.  Press ENT again to enter 
the calibration menu.  Use the UP and DOWN arrows to select SF6 LOW, 
SF6 HIGH, SO2 LOW, SO2 HIGH, H2O LOW or H2O HIGH and press ENT to 
proceed.  The top line of the display shows the current gas value selected 
which can now be edited.  If it is correct then simply press ENT to continue 

 
3) On the edit screen you can use the RIGHT arrow to move the blinking 

cursor across to the character you wish to change1.  Use the UP & DOWN 
keys to change the value.  Note that for ease of editing the cal gases are 
written in % Exponent format so zero would read 0.000E+00% and 100% 
would read 1.000E+02%.  When you have finished editing the value press 
ENT to store it in memory.  This value will remain in memory until you re-
edit them in the future. 
  

4) The analyser now needs to be exposed to the first calibration gas from a 
cylinder (or exposed to ambient air to give a zero point).  Allow several 
minutes to pass to flush the sensor chamber properly and make sure that 
the flow rate over the sensor is the same as when it is in use (0.2-0.5 litres 
per minute is recommended).  Wait for the top line of the display (1) to 
become stable.  To complete the calibration press and HOLD the ENT 

                                                 
1 Note that you can not go back to edit a previous value.  Instead keep pressing the RIGHT button 
and the cursor will wrap around back to the beginning.  Alternatively press ESC to start again. 

7 



Cambridge Sensotec Rapidox SF6 Multimeter Instruction Manual 
 

button for two seconds2.  During this time you will see a bar graph progress 
across the lower display.  The analyser will then recalibrate and display 
“SF6 Low recalibrated” (or similar) and then return to normal run mode.  
The display will now correctly read the value of the calibration gas.   

 
5) To calibrate against the second calibration gas, repeat the procedure from 2 

but this time select a different calibration point. 
 

6) The analyser is now correctly calibrated and will read accurately between 
these two calibration points. 
 

7) If at any time, you encounter difficulties and wish to restore the machine to 
its factory set calibration, use the software provided and load the default 
settings (described in section 7.4 below).  Each machine is provided with a 
unique file that contains the factory settings.  This is located on the CD-
Rom provided and is copied onto your PC during the installation process. 

 
NB You must always perform a FULL calibration to achieve good accuracy.   

6.3 Alarms 
 
The Rapidox is fitted with fully programmable alarms.  There are two independent 
alarm circuits for low and high SF6 conditions.  These are relay circuits which are 
open if there is no alarm and closed when an alarm condition occurs3.  You have 
the option of enabling the alarm circuits, enabling an audible buzzer and enabling 
a visual warning on the screen. 
 
The alarm set points can be programmed by the user via the keypad (6) on the 
front panel or using the software provided (section 7.5.2).  To change the alarm set 
point scroll up the menu to no. 2 “Set Up Alarms” and press ENT.  Now use the 
UP & DOWN arrows to select “Alarm Thresholds” and press ENT.  The next screen 
shows the alarm low setting which can be modified in the same way as described 
in 6.2 for the cal gases.  Press ENT when finished and repeat for the high alarm 
setting.  Press ENT to finish and return to normal operation. 
 
To modify the alarm options select menu no. 5 again and use the UP & DOWN 
arrows to select “Alarm Status”.  Here you are given the option to enable or disable 
the outputs on the rear, enable or disable the audible buzzer & enable or disable 
the warning on the front screen.  Use the UP & DOWN arrows to select each 
option and ENT to proceed and finish. 
 
When the alarm is activated the warning buzzer will sound and the front display 
will flash the word ALARM in next to the SF6 text. 

                                                 
2 Note that if the ‘ENT’ button is released before two seconds have elapsed, the recalibration will be 
aborted and the analyser will return to run mode using the existing calibration 
3 Note that the alarm circuit relays are accessed via the terminal block on the rear panel and are 
clearly labelled.  The relay circuit is rated at 24V 0.5amps maximum. 
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6.4 Analogue Outputs 
 
The Rapidox SF6 Multimeter analyser provides various analogue outputs.  The 
standard industrial analogue outputs (0-5V and 4-20mA) for both SF6 and SO2 or 
H2O , are accessible via the terminal block (7) on the rear panel4.  In the case of 
SF6, the outputs are factory set to provide a linear response in the range 0-100% 
that will cover most applications.  However the lower and upper values are fully 
user-programmable using the keypad (6) or the software provided (section 7.5.2). 
 
The auxiliary outputs can be set to either “SO2” or “H2O” 5. 
 
To modify the SF6 analogue output range scroll up the menu to no.3 “Set Outputs” 
and press ENT.  You can now edit the lower and upper values in exactly the same 
manner as described in 6.2 for setting the cal gas values.  Once programmed the 
new values remain in the memory until they are edited again in the future. 
 
To select and modify the auxiliary outputs scroll up to menu option 3 “Set 
Outputs” and pres ENT three times.  Use the up and down arrow buttons to 
choose between “SO2” and “H2O” and press ENT.  You can then change the low 
and high settings using the same procedure described in section 6.2. 
 

6.5 Setting the Display Units 
 
The notation used by the display (1) is fully programmable to suit your needs 
using the keypad (6) or the software provided.  The following options are available 
to you: 
 
SF6:  The range and notation are fixed 0-100% SF6 in percent format.  Note that the 
display will show a possible range -1 – 110% and will flash if outside these limits 
indicating a calibration is required. 
 
SO2:  The range and notation are fixed 0-100ppm SO2 in parts per million format.  
Note that the display will show a possible range of -1 – 110ppm and will flash if 
outside these limits indicating a calibration is required. 
 
H2O:  The moisture sensor can be user-configured to read in terms of either 
dewpoint (°C dp OR °F dp) or ppm(v). 
 
Temperature: The temperature reading can be displayed in Celsius (°C) or 
Fahrenheit (°F). 
 

                                                 
4 Note that the ranges of the 0-5V and 4-20mA are tied together so changing one alters the other. 
 
5 Note that the fault signal for the auxiliary outputs is 0V / 1mA.  If the thermocouple is 
disconnected then the output will drop to these values to warn the user of a problem. 
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To programme these options scroll up to menu no. 4  “Set Units” and press ENT.  
Use the ENT key to progress through the list and the UP & DOWN keys to select 
the required units.  Once selected press ENT to store and return to run mode. 

6.6 Setting the Display Options 
 
The user can select the LCD refresh rate and the format of the line 2 display using 
the keypad or the software provided.  Scroll up the menu to option no. 5 “Set up 
Display” and press ENT.  Use the UP & DOWN arrows to select either the LCD 
refresh rate or Line 2 Options: 
 
LCD Refresh Interval:  The frequency of the display update can be selected from 
0.1 to 1.5 seconds.  The current setting can be edited using the same method as 
described in 6.2 for modifying the cal gases.  Once edited press ENT to store and 
return to normal operating mode. 
 
Line 4 Options:  The information displayed on line 4 of the LCD can be chosen by 
the user.  The options are Temperature (displayed -40 to 125°C or °F), the date and 
time (displayed as dd/mm/yy hh:mm:ss) or alternating between the two.  Use the 
UP & DOWN arrows to select the display required and press ENT to store and 
return to normal operating mode. 
 

6.7 Setting the Baud Rate 
 
If you are using the software for data logging you can choose the communications 
speed (Baud Rate) by scrolling up the menu to no. 6 “Set Baud Rate” and using the 
UP & DOWN arrows to select either 9600, 57600 or 115200.  Press ENT button 
again to store and return to normal operation.  The default factory setting is 
115200.  However if you are using an older PC you can decrease this to 57600 or 
even 9600 to improve the reliability of the software and data communications. 
 

6.8 Restore Defaults 
 
If you make a mistake programming the Rapidox it is possible to restore the 
machine back to its factory settings by either loading the unique default 
configuration that is supplied on your software CD-ROM OR from the keypad 
menu.  To restore the unit back to its factory select menu option 7 “Restore 
Defaults” and to confirm press and hold the ENT key for two seconds.  The unit 
will now require recalibrating to ensure the sensors are reading accurately. 
 

6.9 On-Board Data Logging 
 
In addition to the more advanced data-logging which is available using the 
software (see section 8) a basic on-board data-logger and memory is available in 
the unit itself.  This allows the user to perform data-logging even if no PC is 
available at that time.  The data-logger will store values for SF6, SO2, H2O and 
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Temperature as well as date and time for up to 2048 data points.  The data will 
remain on the memory chip until it is eventually overwritten.  Both the logging 
frequency and the logging interval can be selected.  The data logger can be started 
and stopped or just left to log continuously.  Note that once the memory is full the 
logger will automatically overwrite the data from the beginning again. 
 
The data in the memory can finally be downloaded onto a PC at any time using 
the software provided.  The data is downloaded in an Excel friendly format.  
Alternatively the sets of data stored in memory can be reviewed on the LCD via 
the “Data Logging” menu item, using the up and down arrows to scroll through the 
points. 
 

6.9.1 Review Data 
 
This function allows you to look at the data stored in the Rapidox memory directly 
on the LCD.  To access the function press ENT and scroll up to menu option 8 
“Data-Logging”.  Press ENT and use the UP and DOWN arrows to select “Review 
Data”.  The next screen will display the last recorded data set.  To see ALL the 
information recorded use the RIGHT arrow key to scroll through SF6 – SO2 – H2O.  
The Date and Time that the sample was recorded are shown on line 3 of the 
display.  In addition to this a unique memory address is shown in the bottom left 
hand corner of the display. 
 
To scroll through the data use the up and down arrows.  Holding down the key 
causes the data scroll to accelerate allowing fast access of the data. 
 

6.9.2 Set Sample Interval 
 
This function allows the user to define how long a time period between data-
points is required.  The factory default is 1 second but this can be changed by 
entering the menu option 8 and selecting “Set Sample Interval”.  Press ENT to 
continue where you will be given an option to change the interval from a choice of 
the following: 1, 2, 5, 10, 15, 30 seconds, OR 1, 2, 5, 10, 15 30 minutes OR 1 hour.  
Press ENT to store the preferred sample interval period. 
 

6.9.3 Set Logging Duration 
 
This function allows the user to define how long the data-logger will run for 
before it stops recording.  The factory default is 30 Minutes but this can be 
changed by entering menu option 8 and selecting “Select Logging Duration”.  Press 
ENT to continue and you will be given an option to change the duration from a 
choice of the following: 1, 2, 5, 10, 15, 30 minutes OR 1, 6, 12, 24 hours.  Finally 
there is an option labelled “Continuous” which keeps the logger running 
indefinitely. 
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6.9.4 Start Logging / Stop Logging 
 
The final menu option available is to either “Start Logging” or if logging is running 
to “Stop Logging”  When you select start the Rapidox will return to RUN mode and 
the display will show a small black circle in the bottom left hand corner (�).  This 
will flash between black and hollow to indicate that a) data-logging is running and 
b) a data set has just been recorded (o). 
 
Please note that there are only 2048 memory locations available.  If you log at 1 
second interval then this will give you just over thirty minutes of data before the 
memory is full and the unit starts to overwrite the data at the beginning.  Likewise 
if you set the logger to run continuously then the memory will continuously be 
overwritten time and time again until you stop the recording. 
 
In the case of a disaster such as a temporary power cut then the data-logger will 
attempt to finish the logging after the power has come back on.  So for example if 
the logging was set to run for one hour at 1pm but there was a five minute power 
cut at 1:25pm then the data-logger would continue from 1:30pm and finish at 2pm 
on schedule. 
 

6.10 Password Protection 
 
The analyser has an option to set a password that will restrict access to the menus.  
The password menu is disabled by default in the factory.  If you wish to password 
protect the analyser press ENT and scroll down to the PASSWORD option (Menu 
option 9).  Pressing ENT again will ask you for the default password which is 
“0000”.  Enter this using the UP and DOWN arrows.  Once the password has been 
entered successfully you can choose between ENABLE and DISABLE in the menu 
using the UP and DOWN keys. 
 
The other option is to RESET the password to a new value.  The password must be 
4 digits long and can be any combination of numbers from 0-9.  Make sure that the 
new password is noted down! 
 
If the password function has been enabled then in the future each time the menu 
system is accessed, the password prompt will display.  After the correct password 
is entered then the full menu will be accessible.  You can make as many changes 
as you want to the options and only press ESC once you have finished.  Pressing 
ESC takes you out of the password protected area and you will have to re-enter the 
password to go back in again. 
 
If the password has been forgotten please contact Cambridge Sensotec who will 
advise you on how to recover it. 
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6.11 RS232 / RS485 Port 
 
It is possible to factory set the data communications port to either RS232 or 
RS485.  Once configured at the factory it is not possible to change unless the unit 
is returned to Cambridge Sensotec Ltd. 
 
Data from the Rapidox is sent on demand to the 9-way 'D' type socket RS232 port 
(8) on the rear panel and can be read using a simple terminal programme such as 
'HyperTerminal' in Windows, or with the user's own custom software.  
Alternatively a simple and convenient data-logger programme is included with the 
supplied software and is described in section 8 below. 
 

6.11.1 RS232 Protocol 
 
Rapidox data can be read from the RS232 port at the back of the unit.  The default 
RS232 configuration is 115200-8-N-1, as shown in this example for COM6 in 
HyperTerminal: 
 

 
Figure 3: Rapidox default COM properties box 

 
Alternatively, the baud rate can be reduced to 57600 or 9600 via the “Baud Rate:” 
menu item, using the front panel keypad on the Rapidox.  This setting is stored in 
EEPROM.  We recommend that the highest stable baud rate is used that is 
compatible with your application. 
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Connection:  Connect to RS232 socket at the back of the Rapidox using a 9 way D-
type plug.  Signals are as follows: 
 
Rapidox D-type Socket:  PC/PLC: 
Pin# 2 = Data Out   Data In (RX) 
Pin# 3 = Data In   Data Out (TX) 
Pin# 5 = Common/Gnd -- Common/Gnd 
 

 
 
 
 
 

RS232 

5 4 3 2 1

9 8 7 6

 
Figure 4: Rapidox RS232 pin configuration 

 
All other pins (1, 4, 6, 7, 8, 9) = Don’t care 
 
Reading Data:  Data is read using command “D”.  Send the single character “D” to 
the Rapidox.  The Rapidox replies with one of the following responses.  All valid 
responses end with [CR] & [LF] (where [CR] = ASCII 13  and [LF] = ASCII 10).  
 
Response: !Initialising[CR][LF] 
Meaning: Rapidox is still initialising 
 
Response: d9.900E+01,2.083E-01,1.372E-

01,2.450E+01,23:19:40,14/01/00,,,ALARM, [CR][LF] 
Meaning: “d” means data is being sent  
 “9.900E+01” is the SF6 reading in % 
  “,” = data separator 
 “2.083E-01” is the SO2 sensor reading in ppm 
 “,” = data separator 
 “1.372E-01” is the H2O sensor reading in the current units 
 “,” = data separator 
 “2.450E+01” is the temperature in the current units 
 “,” = data separator 
 “23:19:40” is Rapidox time in HH:MM:SS format – ignore this 
 “,” = data separator 
 “14/01/00” is Rapidox date in DD/MM/YY format – ignore this 
 “,” = data separator 
 “,” = data separator 
 “,” = data separator 
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 “ALARM” means SF6 alarm is active: SF6 is too high or too low ** 
 “,” = data separator 
 [CR] = ASCII 13 (Carriage Return character) 
 [LF] = ASCII 10 (Line Feed character) 
 
** If SF6 alarm is not set, this data is empty, so the response would look like:  
  
d9.900E+01,2.083E-01,1.372E-01,2.450E+01,23:19:40,14/01/00,,,,[CR][LF] 
 
Response: ? 
Meaning: “D” command was not recognised.  Try to send it again. 
 

6.11.2 RS485 Protocol 
 
Please contact Cambridge Sensotec for further information on this new feature. 
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7. Rapidox Software Instructions 
 

7.1 Software Installation 
 
It is possible to programme a range of variables to the Rapidox using an RS232 (or 
RS485 if configured) link with a PC running MS-Windows (all versions) and the 
supplied Rapidox software.  The software is installed automatically by inserting 
the Rapidox CD into the CD-ROM drive.  If auto-installation does not start then 
you can click the Windows START button and select RUN.  Type X:\setup.exe 
where X is the drive letter of your CD.  Alternatively access the CD from Windows 
Explorer or the ‘My Computer’ icon on your desktop, and double-click on the 
‘Setup.exe’ programme.  Follow the on-screen instructions to install the 
programme onto the hard drive.  Once installed you can access the programme by 
clicking START - PROGRAMS – Rapidox Software6. 
 

7.2 Getting Started 
 
Make sure that the Rapidox is connected to a free serial port on the rear of your 
computer.  These will nearly always be COM1 or COM2 but the software will scan 
through the ports until it finds the Rapidox.  The analyser must be switched on for 
this to succeed and while you are communicating with it.  You can programme the 
variables without a sensor attached, but to monitor the Rapidox properly, the 
sensor needs to be connected and at operating temperature.  On start up the 
software will locate the Rapidox and display the following page7: 

 

                                                 
6 The software has been tested successfully on most language machines including Chinese & 
Japanese. 
 
7 The values displayed in the columns of boxes above the ‘Read’ and ‘Write’ buttons may differ 
from those shown. 
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Figure 5: Rapidox configuration page 

The yellow status box at the bottom will display confirmation that the Rapidox 
was found and the result of the last action, or any error messages if there is a 
problem with communication.  If you experience problems check that your serial 
cable8 (supplied) is correctly fitted to a valid serial port.  Also check the status of 
your COM port settings in Device Manager accessed by clicking START – Settings 
- Control Panel.  

7.3 On-Screen Help 
 
You can access the on-screen help facility at any time by clicking on the help 
menu on the menu bar and select the ‘Help’ option or press F1. 
 

7.4 Configuration Page 
 
The configuration page is split into two and you can toggle by clicking on the 
folder tabs labelled “config 1” and “config 2” page allows the user to reprogram an 
array of variables used by the Rapidox.  Once written to the Rapidox, the new 
variables remain permanent until overwritten. 
 

                                                 
8 There are several types of serial cable available.  You must use a cable as supplied where there 
are straight through connections, i.e., pin 2 to pin 2, pin 3 to pin 3 and pin 5 to pin 5.  Other cable 
formats will not work. 
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To read the current configuration stored in your Rapidox select ‘Read Analyser 
Configuration’ from the file menu.  Note that the edit boxes on the RHS will turn 
red if the value is different to that just read and a red asterisk will appear next to 
the ‘Write’ button to warn you that a change has been made. The left-hand set of 
grey text fields (‘read fields’) will be updated with the current configuration data.  
To save this information (e.g., if several people share the same instrument) press 
the long copy button to transfer the data into the edit boxes, select ‘Save 
Configuration as’ from the file menu and choose a filename.  This data set can be 
subsequently be reloaded at any time by selecting  ‘Load Configuration File’ 
button and selecting the directory where the configuration files have been stored. 
 
If at any time you wish to restore the machine to its factory default settings select  
‘Default  Configuration’ from the file menu to load these values.  The software will 
search for a unique rxc file that is loaded onto the PC during the software 
installation.  The filename is 2100***.rxc where *** is the last three digits of the 
serial number located on the rear of the machine.  This file is also located on the 
CD-Rom that came with the machine.  Normally this file is located in the main 
Rapidox directory but if the software can not locate it then it will ask you for the 
serial number to help it search.  With the correct rxc file loaded simply press 
COPY to transfer the defaults into the edit boxes and then select WRITE to load 
them back into the Rapidox. 
 
The right-hand set of white editable text fields (‘write fields’) is used to enter new 
values to be programmed into the Rapidox.  The values in these fields can either 
be entered manually, or copied across from the ‘read fields’ by clicking the vertical 
‘Copy’ button, and then edited as required9.  Alternatively, you can load saved 
configuration data by selecting ‘Load Configuration’ from the file menu and 
selecting the required file.  In order to programme the analyser select ‘Write 
configuration to the analyser’ from the file menu. 
 

7.5 Reconfiguring the Analyser 
 
The on-screen edit boxes contain variables that can be reprogrammed into the 
Rapidox in exactly the same manner as using the front Keypad.  For a full 
description please refer to the relevant section in this manual.  To access a field, 
either click inside it or use the TAB key to scroll through them. The field 
parameters are as follows: 

7.5.1 Config 1 Screen 
 
1) Temperature Units:  See section 6.5 for a full description.  Use the drop 

down box to select °C or °F.  The default setting is °C. 
 

2) H2O (moisture) Units: See Section 6.5 for a full description.  Use the drop 
down box to select °Cdp, °Fdp or ppm(v).  The default setting is °Cdp 

                                                 
9 Note that when you click on the copy button both pages are updated at the same time and there is 
no need to repeat the action when you toggle to the other page. 
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(dewpoint). 
 

3) Auxiliary Output Parameter: See section 3.7 for a full description.  Use 
the drop down box to select SO2 or H2O.  The default is SO2. 
 

4) Alarm Outputs: See section 6.3 for a full description.  Use the drop down 
menu to select OFF or ON.  When set to ON the alarm circuits on the rear 
are activated.  The default setting is ON. 
 

5) Audible Alarm: See section 6.3 for a full description.  Use the drop down 
menu to select OFF or ON.  When set to ON the buzzer will sound when an 
alarm is activated.  The default setting is ON. 
 

6) Visible Alarm: See section 6.3 for a full description.  Use the drop down 
menu to select OFF or ON.  When set to ON the front display will show the 
word ALARM (flashing) when an alarm is activated.  The default setting is 
ON. 
 

7) LCD Refresh interval:  Use the drop down menu to select a refresh rate for 
the LCD (min 0.1, max 1.5 sec).  The default is 0.3 seconds. 
 

8) LCD Bottom Line Option:  See section 6.6 for a full description.  Use the 
drop down menu to select TEMPERATURE, DATE/TIME or alternating.  
The default setting is TEMPERATURE. 
 

9) Password Protection:  See section 6.10 for full details.  Use the drop down 
menu to either enable the password or disable the function.  Note that if the 
function is already enabled then you will need to enter the password when 
prompted to do so to continue.  You can change the password when 
prompted as well.  Contact Cambridge Sensotec if you are having problems 
remembering the password. 
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7.5.2 Config 2 Screen 
 

 
Figure 6: Configuration 2 page 

 

10) Calibration Gas SF6 High and Low:  Use these boxes to enter new values 
for the SF6 cal gases.  The values must be entered in %.  The defaults are 
0% and 100% which is the full scale range of the SF6 detector.  However 
any two different values can be used as long as you have the accompanying 
cal gas.  Note that the low and high must always be in the right order.   
 

11) Calibration Gas SO2 High and Low:  Use these boxes to enter new values 
for the SO2 cal gases.  The values must be entered in ppm.  The defaults are 
0ppm and 25ppm (common cal gas value) The full scale range of the SO2 
detector is 0-100ppm.  However any two different values can be used as 
long as you have the correct accompanying cal gas.  Note that the low and 
high must always be in the right order. 
 

12) Calibration Gas H2O High and Low:  The moisture sensor is very carefully 
factory calibrated and should not be tampered with unless you have access 
to a chilling mirror.  The range of the sensor is -65C to +20C dp which is 
the factory default values.  Note that you can only calibrate a moisture 
sensor in terms of dewpoint (not ppm(v)) although the sensor reading can 
finally be displayed in terms of ppm(v). 
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13) High & Low Alarm SF6 Thresholds:  Use these two boxes to enter new 
values for the alarm trigger points.  The alarm High value must always be 
greater than the alarm low value.  The value must be entered in %.  Enter a 
value such as 10.1 for 10.1%.  The default values are 110% for Alarm High 
and -1% for Alarm Low. 
 

14) SF6 Analogue Output (0V/4mA & 5V/20mA):  Use these two boxes to set 
the High and Low SF6 values for the analogue outputs (6) on the rear panel.  
For example if you want 4mA to represent 1% and 20mA to represent 100% 
then enter these two values into the appropriate boxes.  The value must be 
entered %.  The default values are 100% for the high setting and 0% for the 
low setting. 
 

15) Auxiliary Analogue Output (0V/4mA & 5V/20mA):  Use these two boxes to 
set the High and Low auxiliary values (see 3 for details) for the analogue 
outputs (6) on the rear panel.  For example if you want 4mA to represent 
1% and 20mA to represent 100% then enter these two values into the 
appropriate boxes.  The value must be entered %.  The default values are 
100% for the high setting and 0% for the low setting 
 

Once you have finished editing the parameters, select ‘Write Configuration to 
Analyser’ from the file menu and the new data set will be written to the Rapidox.  
The Rapidox is reprogrammed using the new configuration.  The software then 
reads the new settings back from the Rapidox and displays them in the boxes on 
the left-hand side confirming that the configuration was successful.  When you 
have finished programming the analyser for new calibration gases you must 
recalibrate the instrument to benefit from the changes. 

7.6 On-Screen LCD 
 
It is possible to display an LCD emulator on the desktop of your PC.  This 
reproduces exactly the display on the Rapidox unit and is convenient if you are 
some distance away from the machine.  To activate the LCD select the utilities 
menu and select the LCD on option.  This will display a small window showing 
the LCD that can be positioned independently anywhere on the desktop. 
 

 
Figure 7: On-screen LCD 

 
The blue LED indicator will flash to show that the display is updating. 
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7.7 Remote Calibrating 
 
With the on-screen LCD display active it is possible to remotely calibrate the 
analyser and clean the sensor.  Click on the down arrow icon in the bottom right-
hand corner of the LCD display to expand the window: 
 

 
Figure 8: Remote calibration and clean function 

 
Use the radio buttons to select which gas type to perform a calibration with.  Make 
sure that the correct calibration gas is flowing through the analyser and the 
reading has settled before proceeding.  Note that you will receive a prompt asking 
you if you wish to proceed before the calibration actually takes place. 
 

7.8 Setting Analyser Date and Time 
 
The current date and time of your PC are displayed on the configuration screen 
and can be loaded into the Rapidox by selecting the Utilities menu and clicking 
the ‘Set date and time’ option.  This information is used in the RS232 data string 
for data logging purposes.  Make sure that your PC clock is set correctly before 
using this function, as you cannot edit the date and time shown by the Rapidox 
software.  The date and time formats displayed are those set in the PC’s Regional 
Settings. 
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8. Rapidox Data-Logging Software 
 

8.1 Introduction 
 
The Rapidox software includes a full data logging facility.  Data can be saved to a 
file automatically at regular intervals and the format is compatible with 
spreadsheet programmes such as MS-Excel.  A live-time graphing facility is also 
included which has many powerful features.  Note that the data logging facility 
will only function if the analyser is in NORMAL run mode (press ESC on the front 
panel). 
 

8.2 Setting up the Data Logger 
 
Click on the tab labelled ‘Data Acquisition’ to display the following page: 
 

 
Figure 9: Data Logging page 

 
During logging, data from the analyser is shown in the central area of this page.  
The data is displayed in the following columns: time (in seconds), the SF6 value 
(%), the SO2 value (ppm), the moisture value (°Cdp, °Fdp or ppm(v)), the ambient 
temperature reading (in Celsius or Fahrenheit), the time (in regional format), the 
date (in regional format), and status (displays the range setting or the word 
ALARM if the alarm is activated). 

23 



Cambridge Sensotec Rapidox SF6 Multimeter Instruction Manual 
 

 
To start data logging select the frequency of measurement by entering a time and 
selecting a unit from the drop down list.  For example if you wish to log data once 
every minute type 1 in the box and select ‘Minutes’ from the drop down menu. 
 
You can open the notes window at any time by selecting NOTES from the ‘Data 
Logger’ drop down menu.  A small text box appears in which you can type a text 
message.  This note is then saved as a header in the data file set and can be viewed 
along with the data. 
 
You can either choose to have data logged continuously until ‘Stop’ is selected 
from the Data Logger menu, or you can choose to set a time limit for data logging 
by checking the box labelled ‘Time Limit’, setting the duration in the ‘Run For’ box 
and selecting units with the drop down list.  For example if you wish to log data 
for thirty minutes type ‘30’ in the box and select ‘Minutes’ from the drop down 
list. 

8.3 Running the Data Logger 
 
If you wish to save the data into a file for later use, check the ‘Save to File’ box 
before selecting ‘Run’ from the Data Logger menu.  You will be prompted for a file 
name and location before data logging commences.  The file and path information 
will appear in the box at the top of the page labelled ‘Data File Name’.  If you 
forget to select file saving before starting a run, you will nevertheless be prompted 
at the end as to whether you wish to save the run data. 
 
The blue progress bar displays the state of completion of the run, and the blue box 
to the right of it the same information as a percentage.  You can stop the run at 
any time by selecting ‘Stop’ from the Data Logger menu.  The yellow Status bar at 
the bottom of the page gives information about the data logging operation. 
 
Once data logging is complete you may open the text format data file using any 
compatible spreadsheet programme such as MS Excel, and use the data to 
generate plots and reports. 
 
You can pause the data logger at any time by selecting ‘datalogger’ and ‘pause’.  
Repeat to continue logging from where you left off, noting that the clock keeps 
ticking during the pause period. 
 

8.4 Auto Date Stamped Files 
 
If you are planning to run the data logger for extended periods of time then you 
should consider checking the ‘Auto date stamped file’ option.  This feature will 
save the data at midnight for the previous twenty four hours and so on until the 
data-logging is complete OR the user interrupts.  The data file is stored with a date 
suffix in brackets in yy-mm-dd format. 
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This feature ensures that data is saved periodically in sensible sized files.  This 
will prevent the computer from crashing and will also ensure that the data is small 
enough to fit into an Excel spreadsheet 
 
As an example, the user wishes to run the data-logger for seven days recording 
every minute starting at lunchtime on 12th November 2005.  He starts the data 
logger with the auto-date stamp function enabled.  When prompted he gives the 
filename as test1.  In this situation the data logger will run from lunchtime to 
midnight and then save the first file as test1 (2005-11-12).  The data logger then 
clears and continues for another twenty four hours until midnight the following 
day.  The data is then stored as test1 (2005-11-13).  This will continue for seven 
days when the data-logger will finish. 
 
After this the user will have a sequence of files: 
 
test1 (2005-11-12).txt 
test1 (2005-11-13).txt 
test1 (2005-11-14).txt 
 
And so on.  Combined together they represent all the data over the last seven days.  
Note that the Rapidox uses the computer clock and date to perform this action, so 
make sure that they are correct before starting a run. 
 
To view the data in its entirety the user would need to load each file in turn back 
into Excel to combine. 

8.5 Live Time Graphing Screen 
 
The Rapidox data-logging package includes a live-time graphing facility that 
allows you to monitor the progress of your data in a graphical format (see Figure 
10).  To access the graph check the box labelled ‘Show Graph’.  The graph will 
appear in a new window, and can be accessed at any time without disturbing a 
run that is already in progress.  You can select  ‘Run’ and ‘Stop’ from the Data 
Logger menu to begin and end data logging, and the window can be minimised to 
(and restored from) the task bar while logging data.   
 
To close the window and return to the main data-logging page select ‘Close Plot’ 
from the File menu or click on the close window button. 
 
The features of the graph window are described below: 
 

25 



Cambridge Sensotec Rapidox SF6 Multimeter Instruction Manual 
 

 
Figure 10:  Live-time graphing screen 

8.6 Main Graph Window 
 
The graph is an XY plot, with time plotted on the X-axis, SF6 plotted on the 
primary Y-axis (Y1) and SO2 or H2O plotted on the secondary Y-axis (Y2).  The X-
axis and the two Y-axes auto-scale during data logging so that all data points are 
shown on the graph. 
 

8.7 Plot Colours 
 
The default colours used on the graph are set to blue for SF6 and red for SO2 / H2O.  
To change the colours double-click on the coloured axis label at the top of each 
axis.  A colour palette window will appear (see Figure 11) and a new colour can 
either be chosen from a colour box, or for more variety, by clicking the ‘Define 
Custom Colors >>’ button.  Click on ‘OK’ to select the new colour or ‘Cancel’ to 
return to the graph without change. 
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Figure 11: Plot colour palette menu accessed by double-clicking on the axes titles. 

 

8.8 Graph Titles and Labels 
 
If you want to change the text of the graph axis labels, place the mouse pointer 
over the text and do a single left click to enter edit mode.  The text can then be 
modified.  Similarly, to change the title of the graph, place the mouse pointer over 
the title and click once to edit.  If you choose not to enter a title the graph will 
display the path and filename of the run as the new title once the run has 
finished.  Note that these changes are only temporary and will be overwritten by 
the defaults if a new run is started or the graph window is closed and reopened.  
They are provided so that the plot may be printed with alternative labels. 
 

8.9 Plot Co-ordinates 
 
The box labelled ‘Plot co-ordinates’ to the upper left of the graph window displays 
the actual plot co-ordinate value at the mouse pointer.  This can be used to get a 
quick SF6 value from the graph.  Simply place the mouse pointer at a place of 
interest and read the corresponding X1 and Y1 values in the box. 
 

8.10 Last data point 
 
During data acquisition, the box labelled ‘Last data point’ will appear at the upper 
middle of the graph window.  It displays the last data values read from the 
analyser. 
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8.11 Using the Cursor 
 
Clicking and holding the left mouse button with the pointer over the ‘C’ at the top 
of the plot area activates the cursor, which appears as a vertical dashed line on the 
plot.  While keeping the mouse button pressed, you can now move the pointer 
anywhere in the plot area or on the ‘C’ in order to move the cursor.  The box 
labelled ‘Cursor’ to the upper right of the graph window will display actual values 
for SF6, SO2, H2O, time and the data point number (n) at or immediately to the left 
of the cursor position.  The cursor can be used to investigate actual data values at 
specific points of interest on the graph. 
 

8.12 Zooming 
 
You can zoom in to any part of the plot by simply placing the mouse pointer on 
the new graph start position and then clicking and dragging a new box to re-size 
the graph.  The label on the box to the upper left of the graph window will change 
to ‘Zoom box co-ordinates’, and an extra set of co-ordinates, labelled X2 and Y2, 
will appear, showing the co-ordinates in X and Y units of the second corner of the 
zoom rectangle as you drag the mouse pointer.  The plot will zoom and auto-scale 
when you release the mouse button.  This can be repeated if you wish to zoom in 
even further.  To zoom back to the original size, select ‘Zoom Full’ from the View 
menu. 
 
Note that although you can use the zoom facility during a live run, the graph will 
auto-scale to full size with each new data point. 
 

28 



Cambridge Sensotec Rapidox SF6 Multimeter Instruction Manual 
 

 

8.13 SF6 Scale 
 
The Y axis is SF6 and is fixed in % scale. 

8.14 Second Y Axis 
 
The secondary Y axis located on the right hand side of the graph can be used to 
display SO2, H2O or Temperature.  To select the mode of the secondary axis select 
‘view’ and then ‘second axis display’. 
 

8.15 Loading an Old Run 
 
A previously logged data file can be loaded and viewed by selecting ‘Open Data 
File’ from the File menu and selecting the appropriate TXT or CSV file.  A 
progress bar is displayed while the data is being imported.  Note that very large 
data files may take several seconds to load.  The data is re-graphed and you can 
zoom, label axes, change colours etc., before printing the graph. 
 

8.16 Printing Graphs 
 
You can print the graph at any time by selecting ‘Print Plot’ from the File menu.  
This will bring up the printer dialogue box for your specific printer where you can 
choose various printing options.  Make sure that the printer page is set to 
landscape to obtain a full size print out. 
 

8.17 Data Logging in the Background 
 
It is possible to begin data logging and then minimise the windows to continue 
working with another application.  To minimise the graph simply click on the 
minimise button on the blue title bar at the top of the window.  You can then use 
the ALT + TAB keys to take you to other programmes already running.  To return 
to the graph simply maximise from the start menu bar or press ALT + TAB again.  
If the graph does not redraw immediately select ‘Zoom Full’ from the View menu 
to redraw. 
 

8.18 Pausing the Data Logging 
 
You can pause the data-logging at any time during the run by selecting the ‘data 
logger’ menu and selecting ‘pause’.  Repeat the action to continue, noting that the 
live graph will draw a straight line between the paused points to keep continuity 
of the axes.  The clock keeps ticking during the pause period. 
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If you decide to access the menu of the Rapidox using the front keypad during 
data logging, then the software will pause automatically.  A message appears on 
the screen informing the user that the unit is being accessed from the keypad.  
Once the menu has been exited, the software will continue data logging from 
where it left off. 
 
If you pause the data-logger you will be able to use the calibration buttons on the 
LCD window (recalibrate the sensor) before resuming the logging 
 

8.19 Changing the Data Logging Parameters Mid-run 
 
Once the data logging has begun you may change the sample interval time by 
pausing the data logger and then entering a new value for the time interval.  The 
data logger can then be resumed with the new values in place.  Note that you can 
not change units (e.g. seconds to hours) once logging has started.  If you originally 
selected seconds then you may change the current value to a new value between 1 
and 3600 seconds, if you originally selected minutes then you may change 
between 0.02 and 360 and if you selected hours you may change between 0.01 and 
6 hours.  Note it is not possible to modify the original total length of time that the 
data logging will run for once a run has commenced. 
 

8.20 Working with Spreadsheets 
 
The data-logger saves data files in a standard comma separated ASCII text format 
which can be readily imported into spreadsheet programmes such as MS Excel, in 
order to produce plots and reports as desired.  For specific information on how to 
import text files into your spreadsheet programme please refer to the help guide 
supplied with the programme. 
 
Data is saved in comma separated value format, with a ‘.txt’ file extension as the 
initial programme default.  However, when entering the file name, you can instead 
select a ‘.csv’ extension: the programme will register the last used file extension as 
the new default.  The ‘.csv’ extension is recognised by MS Excel, so that opening 
the file will automatically run MS Excel, and this may be of benefit if your 
regional decimal separator is period ‘.’ rather than comma ‘,’.  However, if your 
decimal separator is comma, you should continue to use the ‘.txt’ extension and 
open the file explicitly from within your spreadsheet programme, defining the 
field delimiter as ‘comma’ where appropriate. 
 

8.21 Disaster Recovery 
 
To prevent catastrophic loss of important data during a computer crash or power 
failure, the data is automatically saved point by point in a temporary file called 
‘Rapidox temporary data file.txt’.  This file is located in the same directory as the 
main Rapidox programme itself and can be renamed or copied to recover data that 
would otherwise be lost.  Note that this file is overwritten each time ‘Run’ is 
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selected from the Data Logger menu so make sure all data is recovered 
successfully before starting another run. 
 
Note that during a run using the ‘auto date stamped’ feature the temporary data 
file is wiped clean as soon as the previous data set has been saved successfully.  In 
the case of a crash the temporary data file should be used to recover the last day’s 
worth of data that was not saved to the hard disc. 
 

8.22 Diagnostics 
 
The Rapidox software includes a diagnostics page that is accessed from the tab 
labelled ‘Diagnostics’.  This screen will display various values and settings that are 
operating inside your machine.  There is no editing possible on this page – it is 
purely for information and to enable technical support help you should you 
experience difficulties with your machine.  You may be asked to record values 
from this page if trouble shooting is required. 
 
 
Troubleshooting 
 
Q: The Rapidox won't power up at all. 
A: There are fuses located on the power socket on both live and neutral lines.  

These are standard 20mm (1A for 240V versions, 2A for 110V) fuses 
available from a supplier such as RS Components. 

 
Q: The Rapidox gives strange readings that are way off the expected values. 
A: It is most likely a calibration issue.  Check to make sure which two 

calibration gases are selected.  Are they the same as the actual gases you 
used to perform the calibration?  If not you can change their values using 
the software. 

 
Q: The SF6 sensor does not read exactly zero in air 
A: The SF6 detector is a catharometer which responds to changes in the 

thermal conductivity of the gas.  SF6 has a very specific thermal 
characteristic.  However the detector is sensitive to differences between 
gases such as air and nitrogen and damp air versus dry air.  The flow rate 
can also have a small effect on the reading.  To minimise these effects 
always work with the same calibration gas and always use the same flow 
conditions. 

 
Q: I messed up the calibration procedure and the analyser is not working 

properly. 
A: Return the box to the factory defaults using the communications software, 

by selecting ‘Default Configuration’ followed by ‘Write Configuration to 
Analyser’ from the File menu.  Now try re-calibrating the Rapidox.  
Alternatively use menu option 7 on the keypad. 
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Q: The date and time information on the RS232 is incorrect. 
A: The date, time and other features are user-programmable via the 

configuration software.  Make sure that they are correct on the PC you are 
using before attempting to reprogram the Rapidox. 

 
Q: The software will not talk to the Rapidox. 
A: Make sure that you are using the correct cable, as supplied (pin 2 to pin 2 

etc).  A crossed RS232 cable (pin 2 to pin 3 etc.,) will not work.  Make sure 
that your COM ports are recognised by your computer.  Check in your 
Windows device manager to see if there are any conflicts.  If you have an 
internal modem fixed to your PC you may experience difficulties using this 
software.  Contact Cambridge Sensotec for further advice. 

 
Q: I selected ‘Write to the Analyser’ and now the Rapidox is way off 

calibration. 
A: Only select ‘Write to the Analyser’ once all the values are correctly entered 

in the boxes on the right.  The best procedure is to ‘Read Analyser 
Configuration’ and then press ‘Copy’ so the values in the boxes are the same 
as those stored in the Rapidox memory.  You can then edit these values and 
then select ‘Write to the Analyser’ when finished. 

 
Q: How do I get back to the factory calibration for my instrument? 
A:  Select ‘Load Configuration File’ from the File menu and look for the rxc file 

on your CD.  Select this file and then select ‘Write to the Analyser’.  This 
will load the factory calibration back into the Rapidox.  Alternatively you 
can load a standard default configuration any time using the ‘Load Default’ 
option on the File menu.  This configuration will not be perfect for your 
analyser but will be good enough to get you started again. 

 

9. Warranty 
 
The Rapidox SF6 Multimeter has been carefully tested and inspected before 
shipment and is guaranteed to be free from defective materials and workmanship 
for a period of twelve months from date of purchase.  The SF6 sensor head is 
replaceable and has a life expectancy of up to 5 years.  However, if the analysis gas 
contains corrosive gases or large quantities of particulates, sensor life may be 
shortened.  In the case of the latter, it is normally possible to insert a filter prior to 
the sensor head to remove the particulate material. 
 

9.1 Conditions of Warranty: 
 
1) This warranty is in addition to and does not affect any statutory rights of 
consumer purchasers.  This warranty is valid worldwide on a back to base basis. 
 
2) This warranty covers breakdowns due to design or manufacturing faults; it does 
not apply to damage, however caused, wear and tear, neglect, unauthorised 
adjustment or repair, or any items of limited natural life. 
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3) In the event of failure, please take the following action: 
 
a] Refer to the “Troubleshooting” section of your instruction manual to identify 
and possibly correct the problem. 
 
b] If the fault cannot be resolved, please contact the Cambridge Sensotec service 
and repair centre at the address given on the cover of the manual. 
 
4) The warranty period applicable shall be 12 months from the date of purchase. 
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Rapidox CERTIFICATE of CALIBRATION 
 
 
Date:  ………………………. 
 

 
Rapidox Serial number:   ………………………………………. 

 

SF6 High Value (%) ……………………...  A/D Reading: ………………………. 

 

SF6 Low Value (%)   ……………………...  A/D Reading: ……………………….

   

SO2 High Value (ppm)…………………...  A/D Reading: ………………………. 

 

SO2 Low Value (ppm)…………………...  A/D Reading: ………………………. 

 

H2O High Value (°C) ..…………………...  Reading (°C): ………………………. 

 

H2O Low Value (°C) ..…………………...  Reading (°C): ………………………. 

 

 

Configuration Filename   ………………………………………. 

 
 
 
 
 
Calibrated by:    ………………………………………. 
 
 

 

 

Signed:     ……………………………………….

 
Cambridge Sensotec Ltd. 
Unit 8 Royce Court 
Burrel Road, 

 

Tel. +44 1480 462142 
Fax. +44 1480 466032 

www.cambridge-sensotec.co.uk 
sales@cambridge-sensotec.co.uk  St Ives 

Cambs 
PE27 3NE 
ENGLAND 

VAT no. GB 745 939975 
Registered in England No. 4035592 

VAT No. 745 9399 75 
 



Cambridge Sensotec Rapidox SF6 Multimeter Instruction Manual 
 

 

 





Set Logging Duration
(prompts 6)

Duration:  30mins
(prompts 3)

(Options: 1s - 24h OR Continuous)
Use up & down to change)

Duration Set

Displays message for 1.5 seconds

ENT

ESCESC

Start Logging
(Stop Logging)

Start Logging
(Stop Logging)

Displays STOP Logging next timeDisplays STOP Logging next time (6)

Back to Main Display

ESC

ENT

Password: 0***
(prompts 5)

Password: Enable
(prompts 6)

Password EnabledENT

ESC

9-Password Menu
(prompts 2)

ENT

ESC
Enter password - default is 0000 (Options: Enable, Disable, Change) Password: 6234

(prompts 5)

(Enter new password using arrow keys)

ENT

ENT  Enable or Disable selected

8-Data-Logging
(prompts 2)

Review Data
(prompts 6)

ESC

ENT SF6:        0.0%
SO2:        1.0ppm

ENT SO2:        1.0ppm
H2O:     -20.3°Cdp

H2O:     -20.3 Cdp
Temp.:      25°C

ESC ESC ESC

Set Sample Interval
(prompts 6)

Interval:  1s
(prompts 3)

RIGHT RIGHT

 (Options: 1s - 1h Use up & down to change

Interval Set

Displays message for 1.5 seconds
ESC

Back to Main Menu
(No Changes Made)

Use RIGHT arrow to scroll through (10)

ENT ENT

ESC

Wraps around to 1

ESC

ESC

Use RIGHT arrow to scroll through (10) Use RIGHT arrow to scroll through (10)

ESC

ENT

Use RIGHT arrow to scroll through (10)

à = Select Char.
­̄ = Change
ENT = OK
ESC = Back

­̄ = Scroll Menu
ENT = Next
ESC = Exit

­̄ = Change
ENT = OK
ESC = Back

­̄ = Change
à = Select Char.
ENT = OK
ESC = Back

­̄ = Scroll Menu
ENT = Next
ESC = Back

­̄ = Change
ENT = Next
ESC = Back

ENT for 2s = OK
ESC = Back

­̄ = Next/Prev
à = Scroll List
ENT = OK
ESC = Back

Prompts 1: Prompts 2: Prompts 3: Prompts 5: Prompts 6: Prompts 7:

Prompts 8: Prompts 10:

¬

¬

¬

¬

®

¬

®

®

®

®®®

®

®

®

®

®

®

®

­

®

®

­

­

APPENDIX 1: MENU FLOWCHART FOR RAPIDOX 3100C


	1. Introduction
	2. Features
	3. Specification
	3.1 Rapidox SF6 Multimeter Dimensions
	3.2 Accuracy and Precision
	3.3 Display
	3.4 Sensors
	3.5 Calibration
	3.6 Operating Temperature
	3.7 Outputs
	3.8 Data-logging

	4. Technical Specification
	5. Precautions
	6. Rapidox Operating Instructions
	6.1 The Rapidox Analyser - Menu System
	6.2 Rapidox Calibration
	6.3 Alarms
	6.4 Analogue Outputs
	6.5 Setting the Display Units
	6.6 Setting the Display Options
	6.7 Setting the Baud Rate
	6.8 Restore Defaults
	6.9 On-Board Data Logging
	6.9.1 Review Data
	6.9.2 Set Sample Interval
	6.9.3 Set Logging Duration
	6.9.4 Start Logging / Stop Logging

	6.10 Password Protection
	6.11 RS232 / RS485 Port
	6.11.1 RS232 Protocol
	6.11.2 RS485 Protocol


	7. Rapidox Software Instructions
	7.1 Software Installation
	7.2 Getting Started
	7.3 On-Screen Help
	7.4 Configuration Page
	7.5 Reconfiguring the Analyser
	7.5.1 Config 1 Screen
	7.5.2 Config 2 Screen

	7.6 On-Screen LCD
	7.7 Remote Calibrating
	7.8 Setting Analyser Date and Time

	8. Rapidox Data-Logging Software
	8.1 Introduction
	8.2 Setting up the Data Logger
	8.3 Running the Data Logger
	8.4 Auto Date Stamped Files
	8.5 Live Time Graphing Screen
	8.6 Main Graph Window
	8.7 Plot Colours
	8.8 Graph Titles and Labels
	8.9 Plot Co-ordinates
	8.10 Last data point
	8.11 Using the Cursor
	8.12 Zooming
	8.13 SF6 Scale
	8.14 Second Y Axis
	8.15 Loading an Old Run
	8.16 Printing Graphs
	8.17 Data Logging in the Background
	8.18 Pausing the Data Logging
	8.19 Changing the Data Logging Parameters Mid-run
	8.20 Working with Spreadsheets
	8.21 Disaster Recovery
	8.22 Diagnostics

	9. Warranty
	9.1 Conditions of Warranty:


